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Translation Introduction

This guide describes how to translate data from a source language into one or more target languages. There are
three translation methods that you can use:

1. Structured translation: Using a wizard, product data from STEP can be exported into an XML or Excel file
which can then be sent on to a translation vendor. The translated file can then be imported back into STEP.

2. Manual Excel Translation Export: This method allows for a more targeted selection of objects to translate.
Best used with limited data and when the translation work is done without the aid of a translation memory tool.

3. Manual translation: Enables translators with direct access to STEP to translate content in the tool. This
method is best used when there are just a handful of objects to translate. Manually translating content in the
export files is also enabled.

To gain an understanding of STEP's translation processes, we recommend you familiarize yourself with the key
concepts of this guide. It should be noted that this guide assumes that users have a working knowledge of the
STEP system.

If you need information on other STEP components, see the online help or the specific user guides.
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Translations

This topic provides a beginner-level overview of STEP's translation capabilities. In this topic we will discuss the
kinds of objects that are suitable for translation, the various ways STEP enables users to translate content, and a
primer on the various terms and statuses users are likely to find while exporting content for translation. Detailed
guidance covering other aspects of the translation process, like executing XML and Excel exports, importing files,
and handling errors, can be found in their own topics.

STEP enables translation of a wide range of data. Using language-driven contexts, multiple translations can be
created for a single STEP object. This allows an object to be translated into multiple languages while the core
object retains all translated data and inter-language connections.

Briefly, STEP translation works like this: when a user exports, for example, a product hierarchy for translation, all
language-dependent attribute values for those products are extracted for translation. The content is then
translated, often by a translation vendor, and imported into STEP. All translated values flow into the appropriate
attribute in the relevant language context. The second time that same product hierarchy is extracted for
translation, the attribute values are evaluated as part of an automated process, and only those values that are new
or have amended content are extracted for translation.

It is important to note that STEP enables data to be translated but does not translate data itself. Throughout the
guidance on this subject you may see reference made to "starting translation" in STEP. This statement refers to
the act of exporting the to-be-translated content from STEP so it may be sent elsewhere for translation.

Translatable Objects
The object types in STEP that may be translated are:

« Products

« Classifications

« Asset names (names of images and documents, for example)
« Product values

o Indexwords

» LOVs (Lists of Values)

o Units

« Attribute names

o Freetextcellsin tables

Translation Methods
There are three methods available in STEP to extract data for translation:

« Structured translation: Translatable data is exported from STEP into either an XML or Excel file. The file
can then be imported into the translation vendor's translation memory tool. Once the data has been
translated and sent back from the translation vendor, the updated file can be imported back into STEP,
bringing all translated data into its relevant context. It is useful to note that translation XML files can only be
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produced using the structured translation method.

« Manual Excel translation export: A more targeted export of translatable data into an Excel file. This
method is often used to quickly send small amounts of data to a translation vendor to address a late change
to already-exported data. Once the data has been translated and sent back from the translation vendor, the
Excel file can be imported back into STEP, bringing the translated data into its relevant context. All objects
can be translated using this method.

« Manual translation: Data is translated directly in STEP, either by allowing a third party translation vendor
direct access to STEP or by allowing an internal resource fluent in the target language to translate directly in
STEP.

Not all object types can be exported for translation into an XML and Excel file. The table below shows which
translation methods are available for which objects.

Translatable Object XML Translation Excel Translation
Product, classification, asset names, and values | +" v
Index words v v
Free text cells in tables v X
LOVs v v
Units X v
Attribute names v v
Reference / link metadata v X

*Exception: not available for LOVs configured a) to disallow new values or b) without value IDs assigned to the LOV's values.

Translation Relations

In most instances, the objects being translated are subject to revision control, which requires that the data be
approved before it can be exported for translation. This requirement is in place to ensure that different revisions of
an object in translation remain clearly defined. Once the translation is complete, a translation relation is
established from the source language to the target language.

A translation relation refers to the relationship between an object's source language and the language the object is
being translated into, also known as the target language. For instance, if you translate an object in US English into
French, German, and Italian, you have created three translation relations: US English to French, US English to
German, and US English to Italian.
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Translation of Local and Inherited Values

All values that are unique to a given object — also known as "local" values — are extracted for translation. Local
values are non-inherited values; they are added directly to a given object.

Inherited values are values that are inherited from other objects at a higher level. They can be identified by a green
inverted triangle symbol (=) that appears in the icon column. If an inherited value has already been translated at a

higher level, it will not be extracted for translation. When an inherited value is overwritten or revised in any way on
a given object, it becomes a local value to that object. If that higher-level value is then edited, that edit will not affect
the now-local value as it is no longer inherited from that higher-level value.

For more information on inheritance, see the 'Inheritance in the Product Hierarchy' topic in the Getting Started /
STEP User guide.

Translation terms

When managing translations, it's important to understand these terms that reference the various languages
involved in the translation process:

« Master language: The first language used as source language.
« Source language: The language from which a translation originates.
. Target language: The language being translated into.

A source language may be translated into as many target languages as have been set-up on a given STEP
system. In the screenshot below, you can see the Status tab on an object. The user has selected English as the
master language for this object. The user has also elected to translate the object into five target languages: UK
English, German, Hebrew, French, and Danish.

< 13-4 ~pm
Product | Sub Products || References || Referenced By || Images & Documents || Proof View @ State Log | Tasks |
= Revisions
== Workspaces
"? frandation
Master : English P v
[ Teowe > :Target . > |Status |
> English LIK English .RE—TranslaﬁDn Meeded
» ":Engli.s.h :German ?In Progress
> :Engli.sh .j-lebrew :F'.E—Tra-nslaﬁun Meeded
% English .French Re-Translation Meeded
> English Danish In Progress

Translation Status

On each classification, product, or asset you can view an object's translation status, which is the value appearing in
the Status column in the above screenshot. There are two ways to view the translation status of an object:
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« Inthe Tree, select the relevant object, and then click the Status tab. The view will resemble the screenshot
above.

« Inthe Search tab, search for the translation status of specific object types. For more on searching for
translation status, see the Searching for Translation Status documentation.

In the collapsible Translation section of the Status-tab content, the third column is 'Status'. For each Translation
Relation listed in this section, a status is displayed. One of the three statuses listed below will appear here:

Status Description

Re- Translated content in the source language has changed since the most recent translation
Translation | completed. This status indicates a re-translation from the source into the target language is
Needed needed to bring all content up to date.

Upto Date | Notranslated content in the source language has been changed since the previous translation.
Translation from source language into target language is up to date.

In A translation extraction has been done and is currently running as an active background process.
Progress Once the translated content has come back from the translation vendor and the file has been
imported, the background process will complete and the status will update to Up to Date.

Note: System data such as attributes, LOV's and units are not under revision control. Therefore, STEP does not
create a translation relation or a translation status for each language the objects have been translated into. To
learn more about translating these kinds of object types, see the Structured Translation for Setup Objects
documentation.

Preparing Data for Translation

This topic describes how to configure data so that when a user exports content for translation, that data is included
in the translation export file. Users who read and understand this topic should be able to make objects language
dependent, which will in turn make them suitable to be exported for translation. For a more general overview of
STEP's translation functionality, see the Translations topic within this guide.

To translate content in STEP, the various data values that comprise that content must be defined as "translatable".
For example, a customer name may not be useful to translate as it is the same no matter what language or country
it appears in. However, a product's short description would be useful to translate as that description text,
translated into the native language of the target market, would make it more effective.

To define an attribute or other object as translatable, that object must be designated as language dependent.
Typically, this is done as part of the initial data model when content is first brought into STEP, but it can also be
done after an object has already been added.

Listed below are the various methods used to make objects language dependent.
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Specifying language dependency

Before objects in a hierarchy may be extracted for translation, the user must specify which attributes, object types,
and table types associated with that object will be language dependent.

Specifying language dependency at attribute creation
The most standard way to assign language dependency to an attribute is through the Create Attribute wizard
when attributes are first being defined.

Step six in the Create Attribute wizard is called Apply Dimension Dependencies (screenshot below).
Checking the box beside Language here will designate the attribute being created as translatable. When this
attribute is part of a translation export and its status is either Never Been Translated or Requires Re-
Translation, this attribute's value will be included in the export file for translation.

To read more about the attribute creation process, review the Creating Attributes documentation in the System
Setup guide.

[ E] Create Attribute I&

Steps Apply Dimension Dependencies

1, Select Attribute Group

2. Enter ID and Mame

3. Enter Validation Rule

4, select Unit(s)

5. Valid For

6. Apply Dimension Dependencies
7. Link to Hierarchy

[] Country

I Back H Mext H Einish H Cancel

Specifying language dependency on existing attributes

A language dependency can also be applied to any existing attribute by going directly into the attribute via the
System Setup tab.

1. In System Setup, expand Attribute Groups, and then select the relevant attribute.

2. Onthe Attribute tab, in the Dimension Dependencies field, first double click inside the Value cell, and then
click the ellipsis button ( ™ ).
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3. Inthe Select Dimension Dependencies dialog (pictured below), click the box beside Language, and then
click Apply.

System Setup Cable/Wire Type - Attribute
=+ Attribute Groups ~ M References || Attribute Transformation || walidity || Profile [m State Log || Tasks
--ﬁ Attribute Group % Description |
[=H 31 Category Specific Attributes Name N N
Eg E::i:tt:izute_(]mup > B ElEnE e
..... [IT Air gauge incuded * Mame Cable \Wire Type
----- [IT Allowable Ampacities » Last edited by 9015-11-05 15:18:34 by LATO

----- [ Batteries Incuded
Full Text Indexable - F— e en e
..... [IT Battery Type 33 Select Dimension Dependencies

W

System Setup [-BG ;roce-sses“ ” Search “.Iree.

,,,,, DI Brightness » Externally Maintain
----- |1 cable/wire Type > Hierarchical Filtering [ Country
""" I} capacity > [calculated Language
----- (11 circular Area (cmils) m
>
""" [T conductor Gauge b= Level of difficulty of applying changes: 0
..... [f coop » Dimension Dependg E‘
) Operation might be time consuming
""" [IF csa Listed > Mandatory

----- (1T oc Resistance (ohms) -

Cr raphic Ke: C |
----- DI Diameter {mils) yptograph 3 L=
..... [IT Disc Dimensions Attribute Help Text
----- (11 Electrical Product Type

W

W

Bookmarks

W

Completeness Score |I]23 |

Checking Language here will designate the attribute as translatable. This means that when a translation export is
initiated that includes this attribute, this attribute's value will be included in the export file. For more information on
editing attributes, see the Editing Attribute Values documentation.

Specifying language dependency on System Setup objects

A language dependency can also be applied to objects at the level of the object type. Applying the language
dependency here means that all objects of the object type you configure will make the name of that object type
language dependent. Using the sales item object type as an example, if we apply language dependency to the
sales item object type, then all sales items names can be exported for translation. It does not mean that all sales
item values now have a language dependency.

To apply language dependency to an object type, users should follow these steps:
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I — -
System Setup L4 Sales Ttem - Object Type
o [T Alternate Classifications A Il | References || Log
= [}- Assets e otion —
|-z Basic Object Types !
= . Mame »| > |Value s
5 -5 Commercial Types
&) |- Entity user-type root > ID SalesItem
= -z Event Queue Object Types > Name I Sales Ttem I
5 I:-}-lj Primary Product Classification > Last edited by e ee—
] [+ Discontinued Products
=] H
&l B External Products * Mame Pattern
@ (- Packaging Hierarchy » ID Pattern [id]
|“_=| Primary Product Classification > Manually Sorted Yes
-] Product Overrides
E|r_=| Products » Enable Profiling fes
EIE Levell » InDesign Template Allowed Mo
El-{T] Level2 > fean .
[T Level3
- = E EVE l Dimension Dependendes I I;‘
B - @t
= il Item Folder » Reference Target Lock Policy Strict
%I 1"_=| Level4 >
@ [=-{77] Sales Item Folder N
2 [+-[15) SalesItemFamily 1>
% -z Product-Overrides > i
EI - Publication group types > H
& |- Publication section types 5 | Levelof difficuity of applying changes: 0
|-z Publication types |~ o ) _
-3 Setup Group type root > Operation might be time consuming Teem
%Tags >
C |
& Units N ance
Users & Groups - —
- - - > URL AL | |
.( } aaa v

1. In System Setup, expand the Object Types & Structures node, and then select the relevant object type.

2. Onthe Object Type tab, in the Dimension Dependencies field, first double click in the Value cell, and then
click the ellipsis button ( [=:/).

3. Inthe Select Dimension Dependencies dialog that displays, click the box beside Language, and then click
Apply.

Specifying language dependency on table types

STEP also enables language dependency to be set by table type. This enables any free text elementsin a
language-dependent table to be included in a translation export.

To apply a language dependency to a table type, follow these steps:

1. In System Setup, expand Table, and then select the relevant table type. In this example, the table type is
Pivot Table.
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[ B B

!

-/l Table
- 34 Colors
& Rules

El..

% Users & Groups
]"'\h Reference Types
basl Workspaces

=) Table Types

W[ BG Processes (1) ” Search ” Tree

m Compact PartMo
m Compact Price
] compact spedfication Right

..... m LH Compact Spedifications
..... m RH Compact Specifcations
----- i redsold

B3l Table Type

Pivot Table - Table Type

Name >| > |Value > =
* MName Fivot Table
» Edited by [2016-08-09 16:15:03 by USERA =
» Defaults Rule Abowve:0.5 pt Rule Below:0. 5 pt Rule Left:0. 5 pt Rule Right:0.5 pt
> Dimension Dependendies

w

Pagination Plugin

Mone

Default > |Name

@ legalRowTypes

Column Header Row

Compact Bottom Row 1

Compact Header Row 1

Compact Header Row 2

2. Onthe Table Type tab, in the Dimension Dependencies field, click the ellipsis button ( ™ ).

System Setup
@ Users & Groups

lﬁ Reference Types
: Workspaces

P

EI--@ Table

- 34, Colors
&‘}' Rules

=

W[ BG Processes (1) ” Search ” Tree

3.

=1L Table Types
EI% Pivot Tables

m Compact Partho
m Compact Price
m Compact Spedification Right

..... m LH Compact Specifications
..... m RH Compact Specifcations
----- fifl RedBold

.

Table Type

Pivot Table - Table Type

Mame > Value by il
> MName Pivot Table
> Edited by 2016-08-09 16:15:03 by USERA =
> Defaults Rule Above:0.5 pt Rule Below:0. 5 pt Rule Left:0. 5 pt Rule Right:0.5 pt
> Dimension Dependencies |E] |—
> Pagination Plugin Mone

Default » |Name
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System Setup L 4 Pivot Table - Table Type =

u []--@ Users & Groups Bl Table Type
= []"Ey‘ Reference Types =
= 41} Warkspaces Mame *| > |Value L
'% =l Table > Name Pivot Table
h § Colors > Edited by 2016-08-09 16:15:03 by USERA =
— -4 Rules
=) E—}-Eﬁ Table Types > Defaults Rule Above:0.5 pt Rule Below:0. 5 pt Rule Left:0.5 pt Rule Right:0.5 pt
§ Efﬁ Pivot Tables » Dimension Dependencies E] &
@ &[] Pivet Table » Pagination Plugin Mone
= I T T i Bold
&
= O T T T m Compact Partho P Legal Row Types
..... iifl compact Price Default * |Name >
= [N N R O W Compact Specification Right > - ;
EJ _____ % Dumsw P g :_ m Select Dimension Dependencies @
c m LH Compact Specifications i — &
LU': ----- il RH Compact Spedfiations 1>
- T il RedBold >
----- il spec column N | of difficulty of apalving ch
}!iu _____ m Spedfication || Level of difficulty of applying changes: 0
5
%' ----- [ column Header Row || Operation might be time consuming
- T T R R fff! compact Bottom Row 1 >
----- [ compact Header Row 1 @ Apply Cancel
HEEEE = [T compact Header Row 2 »
0000 - [ Mormal Row = =

Structured Translation

Translating content using the structured method is how most STEP users translate large amounts of data. By
selecting objects and initiating the Request Translation Wizard, STEP walks the user through creation of a
translation export XML or Excel file. This section of the translation guide covers:

o structured XML translation
« structured Excel translation
« starting a structured translation

« structured translation of setup objects

Structured XML Translation

In this topic, the basics of exporting translation data into an XML file via the structured translation method will be
covered at a high level, with more detail about the various aspects of STEP translation appearing in other sub-
topics.

Of the available translation options, exporting translatable data to XML using the structured translation format
works best for handling large amounts of content, and is well-suited for enabling automated translation solutions.

When an XML translation export is initiated, an XML file is delivered to a recipient via a configurable delivery
method. The file is sent to a translation vendor where the XML is translated into a target language. When the
updated file is imported back into STEP, all of the translated values are brought into their appropriate attributes.
The method of XML translation that is most often employed involves a STEP user sending an XML export file to a
translation vendor. The XML will be read by the vendor's XML parser, and the information stored in their
translation memory. The vendor's specific methodology, such as reading XML, sending content to an in-country
linguist, QCing the linguist's work, re-importing the content into the vendor's own tool, etc., will process that
translation task and send the content back to the STEP user to be imported.
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The STEP XML Translation also works best when sending content to a vendor that uses a translation memory
tool. For translation work being sent to a vendor that does not have a translation memory tool, an Excel export may
be the better option. For more information on the structured Excel translation export, see the Structured Excel
Translation documentation.

The following objects can be extracted into an XML file for translation:

» Data objects, or objects that contain usable customer data

« Product values

« Classifications

« Freetextcellsintables

« Indexwords

« Asset names (names of images and documents, for example)
« Setup objects, or objects that help organize the data objects

« Asset names (names of images and documents, for example)

o LOVs

o LOV names

« Attribute names (including meta-attributes on attributes)

Itis important to note that setup objects are not under revision control and, therefore, do not require approval to be
exported for translation. Also, attributes and LOVs do not contain any information about translation status and
relations.

Structured Translation Export to XML
A structured translation extraction can be started through the Request Translation Wizard method.

To start a structured translation XML export, click the File menu, point to Translate in the dropdown, and then
select Data Objects or Setup Objects.

File o View Mavigate Format Maintain Window Help

Translatee : Data Ohjects..a

Import : Setup Objects...

Export 3 Manual Excel Translation Export
7 Reports .@] Import Translation...

Bulk Update : Change Translation

Once a user has gone through the Request Translation Wizard this process initiates, they will be able to retrieve
their translation file in the Background Processes tab. These steps are covered in detail in the Starting a
Structured Translation documentation.

For more information about translating setup objects, review the Structured Translation for Setup Objects
documentation.
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Useful Facts About Translation XML
XML Translation Export

When a product hierarchy is exported for translation as an XML file, all attribute values and free text cells are
analyzed by STEP's validation to identify the objects that need translation. This information is displayed in the
Feedback step of the Request Translation Wizard.

Tagging of Translatable Text

The export process results in an XML file in which content that appears betweenthe <TranslatableText>
tags contain the attribute values and free text cell values that need translation.

Tagging of Partial Translation

The first time a product is translated into a target language, all language dependent values are extracted.
However, the next time that product is exported for translation into the same target language, only new or changed
values are extracted and appear between <TranslatableText> tags in the exported XML file. This is called partial
translation.

Note: If one value in a multi-valued attribute is modified in the source language, then that attribute goes into Re-
Translation Needed status and all values in the attribute will be extracted for translation.

Translation of Free Text Cells in Tables

Using the structured translation method, you can translate free text cells in tables if the table type in question has
been pre-defined as language dependent.

Structured Excel Translation

This topic provides an overview of the basics of exporting translation data into a Microsoft® Excel file using the
structured translation method. In this guide, users will learn which objects can be exported into an Excel document
for translation, where in the workbench a structured Excel translation export can be started, and how to read an
Excel translation export document.

Exporting translation data into an Excel file using the structured translation method enables manual translation of
content within an Excel file. When the translation has been completed, the updated Excel file can then be imported
back into STEP, bringing all of the translated values into their appropriate attribute.

Of the three methods available to extract content from STEP for translation, the structured Excel translation
method is best deployed when:

« there is a small amount of content to be translated
« the translation vendor does not make use of a translation memory tool

If either of these criteria are not met, the structured XML translation export is often the better option. For more
information on this, see the Structured XML Translation documentation.
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One potential drawback to this translation method is that there is a greater chance of introducing data
inconsistency into the object being translated. This stems from the fact that the translated values are entered
manually by the translation vendor; adding the data correctly requires additional care to be taken by the user.
Further, special characters like the greater-than and less-than symbols (> and <, respectively), double and single
quotes, or the double prime (to denote lengths measured in inches), must be mapped in STEP prior to export. If
this is not done, the file is likely to error on import.

The following objects can be extracted into an Excel file for translation:

Data objects, or objects that contain usable customer data:

o Productvalues
o Classifications
o Product

« Asset names (names of images and documents, for example)

Setup objects, or objects like LOVs and attribute names that help organize the data objects, cannot be exported
to an Excel using the structured translation process. The Manual Excel Translation Export is the only method
available to bring these objects into an Excel file.

Note: Free Text cells in tables cannot make use of the Excel translation method. To translate this object type, the
structured XML translation or manual translation method should be used instead.

For more information on which objects can make use of which translation methods, see the Translations
documentation.

Excel Translation Export

An Excel translation extraction can be started either through the structured Request Translation Wizard
method, or by selecting the Manual Excel Translation Export option. For more information on the Manual Excel
Translation Export option, please see the Starting a Manual Excel Translation Export documentation.

To start a structured Excel translation from the File menu, first point to Translate and then select Data Objects.

Fileﬂ: View Mavigate Format Maintain Window Help

Tra nslatee ] Data Ohbj EL‘tS..e

Import ; Setup Objects...

Export ; Manual Excel Translation Export
# Reports @] Import Translation...

Bulk Update : Change Translation

Once a user has gone through the Request Translation wizard this process initiates, they will be able to retrieve
their translation file in the Background Processes tab. These steps are covered in detail in the Starting a
Structured Translation documentation.
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Itis important to note that LOVs, units, and attribute names, also called setup data, cannot be translated within the
structured Request Translation wizard method of exporting translatable content to an Excel file. They can be
exported for translation using either the manual translation method, or by executing a Manual Excel Translation
Export.

See the table below for a breakdown of which objects can be exported using the structured and manual Excel
translation export methods.

Translatable Object Structured Excel Manual Excel
Translation Translation

Products, classifications, and image and document v v

names

Product values v v

LOVs X v

Attribute names X v

Units X v

For more on translating setup objects, see the Structured Translation for Setup Objects documentation.

Translation Excel File Features

The Excel file features a color-coded cell format that quickly alerts the user to each element's status. Below is a
sample of what a user might find in an exported Excel file:
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E:I Battery 3638-Battery 4242.xls [Read-Only] ' . & |I:I|5|
A, B | C =

Product: Battery 3638

3

4 Source: English Target: German
5 (1D Battery 3533 Battery 36533

E [Name Battery 3635 Battery 3635

7 |Text attribute Jtext{ This battery can last forever

2 |Attribute 1 [text{110

9 |Key words [text{500

10

11 Product: Battery 4242

12 Source: English Target: German
13 1D Battery 4242 Battery 4242

14 |[Name Battery 4242 Battery 4242

15 |Text attribute [text{’ This battery cannot last for ever and ever
16 |Attribute 1 [text{110i e
17 |Key worids [text{500

18

10

4 4 » M[4Translation sheet / | «] | LI o

There are only four cell-shading colors a user may encounter in an Excel export file:

Background color Description

Blue The product name

Green Product information to be translated

Yellow Product information that does not need translation

White Product information that has already been translated and approved

The first time a product is translated into a target language, all values are extracted; however, the next time the
same product is exported for translation into the same target language, only new or changed values are extracted.

If one value in a multi-valued attribute is modified in the source language, then all values are extracted for
translation again.

To translate all values again regardless of their previous translation status, on the Status tab, under Translation,
in the Status column, select Re-translation Needed.
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Excel Translation Import

When you import an Excel translation file, the translated values are imported into the STEP database. The
structured translation process controls the entire import process, regardless of how the Excel file was exported.
For more information on importing Excel files generated through the Request Translation wizard, please see
the Importing Translation Excel Files documentation.

Starting a Structured Translation

This topic describes, step-by-step, how to initiate a structured translation export of STEP content into an Excel or
XML file. Users who read and understand this topic should be able to produce a file suitable to send to a third-party
translation vendor for translation. Other translation methods supported in STEP are covered in their own topics.

To initiate a structured translation export you must access the Request Translation Wizard. To do so, open the
File dropdown from the menu bar, select Translation, and then click Data Objects... (initiating an export for
Setup Objects is covered in the Structured Translation for Setup Objects documentation).

File o Wiew Mavigate Format Maintain Window Help

Tra nslatea : Data Cll::ljects..a

Import ; Setup Objects...

Export : Manual Excel Translation Export
# Reports b Import Translation...

Bulk Update : Change Translation

The Request Translation Wizard guides the user through five steps that enable the user to adapt the translation
export to their specific requirements.

© Stibo Systems - Confidential - STEP Trailblazer 8.1 18



StiboSystems

Step 1 - Object Selection

331

Steps Object Selection

1. Object Selection Selection
2. Select Target Language (@) From Root Node

3. Feedback Root Node 88723-12 (100914)
4. Delivery (") From List
5. Schedule Extract List File
File Contains Product IDs
() From Collection
Collection

Refresh Automatically

Filter Options
Include Mot Translated Re-Translation Needed

Approval Requirement Completely Approved Source

Include Super Types | Products “

Include Object Types <Al object types>

Back Mext Finish Cancel

The first step in the Request Translation Wizard is Object Selection. In this step, the user selects which objects
should be included in the translation export, and from where in STEP the objects should be pulled. There are two
sections in this screen, each with a number of options included within.

In the Selection portion of the Object Selection step, the user indicates from where in STEP the content to be
translated should be pulled. There are three ways to select that content.

Selection
(®) From Root Node
Root Node 88723-12 (100014)
() From List
List File
File Contains Product IDs
() From Collection
Collection
Refresh Automatically
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« From Root Node: For importing objects directly from the Tree. If the user has started the Request
Translation Wizard while standing on an object in the Tree, that object will pre-populate the Root Node
field. If the user wishes to change the selection, clicking the (e button will bring up a screen allowing the user
to either Browse the Tree for the object, or Search for the object by typing the sought-for object directly into
the search field.

« From List: Forimporting a file with data to be translated. This is different from the structured translation
import function (covered in detail in the Importing Translation Excel Files documentation and the Importing
Translation XML files documentation) in that the file being imported does not contain already-translated
content. In the field entitled List File, click the ™ button to browse or search your computer's folders for the
appropriate file. In the List Contains field, click inside the field to display a dropdown. Select from the listed
options whether the data being imported contains Product IDs, Product Names, Classification IDs,
Classification Names, Asset IDs, or Asset Names. There is no option to multi-select here.

Note: There are no formatting rules for the Excel file you select. If it is a single column of product IDs with no
heading and not other content, that is perfectly acceptable. When you select which kind of object type you plan to
import, STEP will look for valid IDs for those objects, and will import only those for which it can match to a valid ID.

« From Collection: For importing a manually selected grouping of various object types (which can,
potentially, be from multiple super types) grouped in a collection. In the Collection field, click the led button
and either browse or search for the collection to be translated. If the collection is based on a search and you
want to ensure that new or amended values in the collection are captured prior to exporting for translation,
click the box beside Refresh Automatically.

In the Filter Options section of the Object Selection step, the user can specify object type and the status of the
objects that should be included in the translation export being created.

Filter Options
Include Mot Translated Re-Translation Needed

Approval Reguirement Completely Approved Source

Include Super Types |Products
Incude Object Types <Al object types=

« Include: Users may elect to include or exclude values that are Not Translated or values that have been
amended and are thus designated as Re-Translation Needed. Click the boxes next to each to include them
in the filter. One or the other must be checked to proceed. Otherwise, the Next button will be inactive.

« Approval Requirement: By checking the box beside Completely Approved Source, the user is waiving
the requirement that all objects must be fully approved prior to being translated.

« Include Super Types: In this field, users may click the dropdown to select which super types should be
translated. This field is only activated after a user has selected one of the prime selection methods in the
Selection section above, and then defined a node, file, or collection from which to start the translation. The
super type options are Products (also the default), Classifications, Assets, or All. Because the Excel
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translation method does not allow for mixed super types, if the All option is selected here, the Excel will be
unavailable as a translation method in a later step (Delivery).

Include Object Types: In this field, users may select which object types should be included in the
translation export. This field is only activated after a user has selected one of the prime selection methods in
the Selection section above, and then defined a node, file, or collection from which to start the translation. To

specify which object types to include, click the ***! button. This brings up a Select Object Types window.

8% Select Object Types

() All Object Types

(®) Spedfy |LE'u'EI1

Search

LT_I‘- LASLETIUNgeEd Frouuc s
IE’ External Products q
i Packaging Hierarchy
rj Primary Product Classification
E Product Overrides
El|j Products

=115 Levell

rj Level2

== Details

Ok Cancel

« All Object Types is the default selection in the Select Object Types window. If the user wishes to
include all object types included under the super type selected in the previous field, there's nothing to
do in this window. If, however, the user wants to include only a subset of object types in their export,
they may select Specify. This activates the Browse and Search tabs that enable users to select the
object types that should be included. To add the object type the user should first select it in either the
Browse or Search tabs, and then click the right-pointing arrow to bring it into the box where all included
object types are collected. Conversely, to remove object types to be included, select the object type
and then click the left-pointing arrow.

« Ifthe user has opted to translate the objects contained inside a collection, the Include Super Types
field should be set to 'All'. If the user wants to include a subset of object types within that collection,
clicking the ] beside Include Object Types will bring up a Select Object Types window that

contains the three super types (Products, Classifications, and Assets) from which to select child
objects.
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3% Select Object Types

() all Object Types

(®) Spedfy
r_=| Alternate Classifications 4

Assets
[#-IF) Primary Product Classification

= Details

Cancel

Step 2 - Select Target Language

P

E! Request Translation =l
Steps Select Target Language
1. Object Selection Translate from English
2. Select Target Language  Select Target Language(s)
il FEEdJEIdC D Danish
el [] French
5. Schedule Extract
[] German
[] Hebrew

[] Language Root
[] UK English

Back Mext Finish

Inthe Select Target Language step, the user is prompted to select the language they would like to translate their
content into. Click the language or languages that are applicable and click the Next button. It is also possible to
click the Finish button, which will begin the export process immediately, provided there are no errors.

Note: If you select multiple languages, the objects listed in the next step, Feedback, will not be accurate. The
data shown on the Feedback screen will be for just one language, not all of the selected languages.
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Step 3 - Feedback

T

E] Request Translation L EE..'
Steps Feedback

1. Object Selection

2. Select Target Language |

3. Feedback _ :
4, Delivery Object Type * [Total Count ¥ [Extracted Count s | |8
5. Schedule Extract TtemFamily IR 1
\ID * [Name * |Reason ¥
100914 |8723-12 [+ Mot Translated
I Back I I MNext I l Finish I I Cancel I

The Feedback step's primary function is to provide the user with reporting about the objects slated to export so
the user can know what precisely will translate before starting the export. On this screen the user will see listed all
of the objects that will be included in the translation export. The breakdown of this data is captured in two tables.

The first table is the summary of what will be included in the export. This is the data it presents:

« Object Type - The different kinds of object types that will be included in this extraction. In this example, there
is one object type: ItemFamily.

» Total Count - The total count of each object type that will be included in the extraction. In this case, there is
one instance of the ltemFamily object type included in the extraction.

« Extracted Count - The number of each object type that will be included in the translation export.

The second table is a list of all of the objects that will be part of the extraction.

« ID - The STEP ID of the object being translated.
« Name - the STEP name given to the object being translated.
« Reason - The listed reason why it is being included or excluded from the extraction. A green checkmark (

v ) indicates that it will be exported. A red X ( x ) indicates that it will not be exported. Below are some of
the reasons a green checkmark will appear or a red X might appear:

. H Up to Date: objects will not be exported
. v Not Translated: objects will be exported for translation

. H Not Approved: objects will not be exported (not applicable if the 'Completely Approved
Source' requirement is unchecked in the Object Selection screen)

© Stibo Systems - Confidential - STEP Trailblazer 8.1 23



StiboSystems

. x Not in Approved workspace: objects will not be exported because they are only in the Main
workspace and not the Approved workspace (Regardless of whether the 'Completely Approved
Source' requirement is checked, translation only pulls content from the Approved workspace. If
the object has no data here, then the object will not be included in the export)

. v Re-translation Needed: objects will be exported for translation
. H In Progress: objects will not be exported because they are already being translated

. x Invisible in Target: objects are not visible in target language and will not be extracted for
translation

. H No translation to source: objects will not be exported because the source>target translation
being requested is invalid. For instance, let us say a translation relation exists for an object from
English to French with English set as the Master language. The user then requests a translation
be started from French to English. Because English is set as the master language for the object
being translated, this object cannot be included in a French to English translation, and the 'No
translation to source' status will display for that object.

. x No translatable content: objects will not be exported as there are no values that are language
dependent

The second table in the Feedback screen will display up to 1,000 items. If there are more than 1,000 items, a row
of text will appear in the second table that reads, 'More than 1,000 objects, only first 1,000 is shown...". To see all
the objects, click the Report button in the upper right corner of the Feedback screen. The objects will then be
exported into a single-column CSV file for review.

For each object listed in the CSV file, there is a + sign (will be included in the export) or a - sign (will not be
included), followed by the reason for why it is or is not included in the export.

Here's an example from the CSV file of an object that will not be extracted for translation. Note the minus sign:

Translation Details
ProductObject TypelncludedReasonReferenced
88723-12 |{1EI-EI'5|14}ItemFamilﬂn Progress-

Here's an example from the CSYV file of an object that will be extracted for translation. Note the plus sign:

Mens T PBG w Class (179925)ltem-Not Approved-
Mens T PGW [MT18403) Item-Not Approved-
Cotton T-Shirts {IEZDE}ItemFamiI‘EJGt Translated-
18216 L O [181951}Item-In Progress-

Mens T PGS (MT18402)Item-Not Approved-

If the user already knows they want the translation data exported as an XML file, they may click Finish. However,
if the user wants an Excel file, or the XML file delivered in a format other than the default (file), they must click the
Next button to manually configure the delivery aspects of their export.
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Step 4 - Delivery

E] Request Translation @
Steps Delivery
1. Object Selection Translation Method: XML F]
e LA Filter spreadsheet: :
3. Feedback
4. Delivery Delivery Method: IEM'::EI AN,

5. Schedule Extract Skip Verification:

Delivers exported data in a file. You will be notified when the file is ready for download,

Process Name: 13202

I Back || Mext H Finish || Cancel I

In the Delivery step, the user specifies whether their content should be exported into an XML or Excel file, and the
method in which that file should be delivered.

Translation Method - From the dropdown, select either XML or the relevant Excel version

Filter spreadsheet - If either of the Excel versions have been selected from the Translation Method dropdown,
the user may select Filter spreadsheet. This ensures that only the attribute values that require translation are
included in the export (those objects that received the v in the Feedback screen). Objects that do not require
translation (those that received the x in the Feedback screen) are excluded when this option is selected.
Delivery Method - Choose one of seven options that determine by what method the user will receive the

exported translation file. Dependent on how a user's specific STEP system has been configured, some of these
options may not be available.

The available export options depend on your system setup. The commonly used delivery methods are:

« Deploy: Delivers afile to a specified directory

« Email: Delivers a file as an email attachment. The user must specify the email address of the recipient, a
subject, and the body text

« File: Delivers afile in the background process. The user is notified when the file is ready for download

« FTP: Delivers afile using file transfer protocol (FTP). The user must specify the host name, user name,
password, and the file name used to deliver the file

« Server Side Delivery: Exports the file into a folder located on the Application Server of the STEP system.
The file is only delivered if the specified path has read / write access on the server

« SFTP: Delivers afile using the Secure File Transfer Protocol (SFTP). The user must specify the host name,
user name, password, and file name

« Websphere Commerce Import: Depends on a user's system setup
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Check the box for Skip Verification if you are certain that all of the objects listed in the Feedback screen are
correct to export. Checking this box prevents suspension of the export process until a user visits the export's
background process and confirms the export may proceed.

Step 5 - Schedule Extract

-

E] Request Translation @
Steps Schedule Extract
1. Object Selection Start
2. Select Target Language
3. Feedback ® Now
4. Delivery Later
5. Schedule Extract
Weekly
) Manthly
*) Later and repeat
Start now
Back Mext | [ Finish | Cancel I

In the Schedule Extract step, the user may select one of five scheduling options for when STEP should proceed
with the translation export.

Now - Clicking Finish initiates the export immediately.

Later - Brings up two additional fields, Start at (hh:mm) and Start on (yyyy-mm-dd). The user sets the time
and date and STEP completes the translation export at the configured time.

Start at (hh:mm): 15:28
Start on (yyyy-mm-dd): 2016-03-05

Weekly - Allows the user to create a recurring export to execute once or multiple times a week. The user sets the
time and date to start, the date at which the weekly export will end, and then the day (or days) of the week the
export should run until the configured interval has elapsed. One or all days of the week can be selected here.
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Start at (hh:mm): 15:28
Start on {yyyy-mm-dd): |2016-08-05
End on (yyyy-mm-dd):

Ewvery: W | Mon
Tue

Wed

Fri

Sat

Sun

StiboSystems

Monthly - Allows users to set a recurring translation export once a month. The user sets the time and date to start,
the date at which the weekly export will end, and then a non-date-specific day in the month at which the export (or
days) of the week the export should run until the configured interval has elapsed. For example, the monthly export

can be scheduled for the first Monday of every month.

Start at (hh:mm): 15:28
Start on (yyyy-mm-dd): | 2016-08-05
End an (yyyy-mm-dd):

Ewery: First

Monday

Later and repeat - Allows users to create a recurring export that can be auto-initiated multiple times a day. In
addition to the time and date fields, the user can set the number of minutes between auto-exports.

Start at (hhzmm): 15:28
Start on (yyyy-mm-dd); |2016-03-05
End on (yyyy-mm-dd):

Ewvery: First

Monday

Use the Later and repeat scheduler with caution as it is possible to set up a recurring export as often as every few
minutes. If the intended interval is improperly set, the STEP system can experience negative performance issues.
For instance, if the Delivery Method of the export is set to ship to an FTP for a translation vendor to retrieve, and
the vendor's tasked with processing all files they retrieve, the user could incur unexpected costs.

When the export schedule has been configured, click Finish, and the translation exports will commence according

to the schedule you have set.
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Reviewing Product Status

When a structured translation export process has been initiated, a few final steps must be taken in that export's
background process. If in the Schedule Extract screen you selected Now, a small window will display showing
two options: Go to Process and Close.

I Y

E] Starting process 135833 @

Starting process "135833 (Translation).
Process started

I Go to process I[ Close

Click Go to process to go directly to the export's background process. Click Close if you are not able to progress
the translation at that moment. To access the background process directly at a later date, click the BG Processes
tab, expand Translation, and then expand Active Processes. Click on the relevant process and view the Result
section.

If more than one target language is selected, a background process will be created for each target language, each
process creating its own file.

1. The translation produces an Excel file listing all of the objects that are included in the export. These listed
objects are the same objects that displayed on the Feedback screen. To view the spreadsheet, click the disk
icon and follow the prompts.

D Result

Step Query Done

Review outcome of the translation analysis: statusfile_BGP_13500.csw |
Do you want to export these products for translation? [ Yes |[ Mo |

2. A prompt below the report file asks, "Do you want to export these products for translation?" Click Yes to
proceed with the export. Click No to abort the export. If the user has checked the box for Skip Verification on
the Delivery screen, then the export proceeds directly to generating an export file, and there is no question for
the user to answer.

3. Toexport the products for translation, click Yes. A zip file is created that contains the data to be translated.

If you click No, the translation export is ended, and the translation status of the selected objects is not changed.

4. Click the Save icon to save the zipped translation file.
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9 Result

Step Wait for Translation

Review outcome of the franslation analysis: statusfile_BGP_13500.csv
Exported translation files: wmitranslation_BGP_13500.zip

Structured Translation for Setup Objects

This guidance outlines how to create translation export files for Setup Objects, which refer to LOVs (or List of
Values), attribute names, and units. Users who read this guidance should be able to create an export file for these
setup objects, and understand how the content is displayed in the XML export file. For information on translating
Data Objects, please see the Starting a Structured Translation documentation.

There are three kinds of objects that must be handled differently than all the others: LOVs, attribute names, and
units. In STEP these kinds of objects are classified as setup objects. Setup objects do not register a translation
status, meaning STEP does not track whether they are "Up to date" or "Re-Translation Needed". The primary
reason for this is these objects are rarely translated more than once, negating any value that might come from
tracking their status. For instance, the purpose of an LOV is to provide the user with a pre-set list of options that are
common and recurring. Translating an LOV means that this list of common and recurring dropdown values is
available in each target language. If the LOV is being translated again and again, it means the values in that LOV
are either being changed or new values added frequently. If that is the case, it's likely the object should not be an
LOV but rather a multi-valued attribute.

Because STEP does not track changes to setup objects, users must manually track any changes made to these
objects.

Before setup objects can be exported for translation, some criteria must be met:

« Both LOVs and attribute names must have a language dimension dependency.
« LOVs must be configured so that the values that comprise them have IDs.

If these criteria are not met, these objects cannot be exported for translation. If these criteria are met, then they can
be exported for translation either by using a Manual Excel Translation export or through creation of an XML file
using the structures translation method.

Generating Translation Export Files for Setup Objects

The process required to initiate translation exports for setup objects is not significantly different from the process
for data objects. With that in mind, listed below are the differences to consider when initiating translations for setup
objects that make the process different from that of data objects.

Exporting to XML
1. Ensure that the context is set on the correct source language context.

2. From the File menu, click Translate, and then select Setup Objects.

© Stibo Systems - Confidential - STEP Trailblazer 8.1 29



P

StiboSystems

-de'.r - USERE@http://doc-dev:80 - STEPworkbench

dit View Mavigate Format Maintain Window Help
Translate 9
Import
Export
# Reports
Bulk Update

Data Objects...

Setup Objects... B

Manual Excel Translation Export
b Import Translation...

Change Translation

3. Onthe Object Selection step, in the Selection area, users may select either the From Root Node or From
Collection option. If you have navigated to the correct Attribute or LOV in the System Setup tab, then the Root
Node field will be pre-populated with that object. Otherwise, you can click the ellipsis button ( ™ ) and navigate
to the attribute or LOV group that you want to export for translation, and then click Next.

4.

-

E] Request Translation

1

(7 From Collection

Collection

Refresh Automatically

| &2 |
Steps Object Selection
1. Object Selection Selection
2. Select Target Language @ From Root Mode
Lotz Root Mode Drinks (Drinks) E]
4, Deli
nery From List
5. Schedule Extract
List File
File Contains Product IDs

Filter Options
Indude

Approval Reguirement

Indude Super Types All

Indude Object Types

Mot Translated

Completely Approved Source

Re-Translation Meeded

<Al object types =

Cancel

Inthe Select Target Language(s) step, select a target language, and then click Next. It is recommended that
only one target language is selected for each export of Setup Data because if two or more languages are

selected, the Feedback screen will display no results.
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You may notice that if certain target languages are selected, additional languages will appear in brackets to the
right of that language. If one language is used in two or more contexts (for example, the French language used
in both the France_French context and the Belgium_French context), then all contexts associated with that
language will be displayed in brackets.

5. The feedback screen provides you an overview of the items that have been extracted for translation. Because
setup objects are not under revision control, no translation statuses will display. In the Reason column, only
the value "Unknown" will appear.

i

E] Request Translation @
Steps Feedback

1. Dbject Selection

2, Select Target Language Report

3. Feedback
4, Delivery Chject Type * Total Count » |[Extracted Count > *
5, Schedule Extract Domains 2 2
0 * [Name * |Reason >
Coffes (Coffee) o Unknown
EnergyDrinkLOV (EnergyDrinkLCOV) " Unknown
I Back I | MNext | I Finish J I Cancel

6. InDelivery, select a delivery method, and then click Finish.

The structured translation will then export the data into an XML file.

Note: Setup objects can not be exported into an Excel file using the structured translation method.

XML Export of Setup Data

LOV

Displayed below is an example of an LOV and its three component values exported for translation. In this case, the
LOV name is Colors, the target language is German, and the values (highlighted in yellow) are Yellow, Green,
and Red. In this instance, these values are to be translated into German.

<STEP-ProductInformationTranslation ExportTime="2013-03-27 10:06:21" ExportContext="EN All
All" ContextID="EN All AIl"

WorkspaceID="Main" wfmProcessTemplateName="Translation"
wfmProcessID="BGP_ 768298" translationTarget="German" PendingFileName="translation.xml">

<ListsOfValues>
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<ListOfValue ID="Colors" UseValuelID="true" AllowUserValueAddition="false" ParentID="List
Of Values group root">

<Name>Colors</Name>
<Validation InputMask="" MaxLength="100" MaxValue="" MinValue="" BaseType="text"/>
<DimensionLink DimensionID="Language"/>
<Value ID="634592" QualifierID="en"><TranslatableText>Yellow</TranslatableText></Value>
<Value ID="634593" QualifierID="en"><TranslatableText>Green</TranslatableText></Value>
<Value ID="634594" QualifierID="en"><TranslatableText>Red</TranslatableText></Value>
</ListOfVvalue>
</ListsOfvalues>
</STEP-ProductInformation>
Next, a translation vendor would receive this data, translate the data, and then send the updated XML file with the
translated values back to user. Subject to how the workflow has been configured between the user and the

translation vendor, the updated XML file is then imported back into STEP, and the translation of the setup data is
complete.

Attribute Name

Displayed below is an example of an attribute name and an attribute metadata value exported for translation (the
text to be translated is highlighted in yellow). In this case, the attribute name is Color Attribute, and the metadata
attribute is Description, for which the value is This color attribute is supposed to be used for cars.

<STEP-ProductInformationTranslation ExportTime="2013-03-27 10:06:21" ExportContext="EN All
All" ContextID="EN All AIl"

WorkspaceID="Main" wfmProcessTemplateName="Translation"

wfmProcessID="BGP_768299" translationTarget="German" PendingFileName="translation.xml">
<AttributeList>

<Attribute ID="Color" MultiValued="false" ProductMode="Property" FullTextIndexed="false"
ExternallyMaintained="true"

Derived="false" HierarchicalFiltering="false" Selected="true" Referenced="true">
<Name><TranslatableText>Color Attribute</TranslatableText></Name>
<ListOfValuelink ListOfValueID="Colorsl"/>
<DimensionLink DimensionID="Language"/>
<MetaData>

<Value AttributeID="Description"><TranslatableText>This color attribute is

supposed to be used for cars</TranslatableText></Value>

</MetaData>

<AttributeGroupLink AttributeGroupID="AAKAl"/>

<UserTypeLink UserTypeID="Product"/>

<UserTypeLink UserTypeID="LATS TEST OT"/>

</Attribute>
</AttributeList>

</STEP-ProductInformation>
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As with the LOV example, a translation vendor would receive this attribute name data, translate it, and then send
the updated XML file with the translated values back to user. Subject to how the workflow has been configured
between the user and the translation vendor, the updated XML file would then be imported back into STEP. The
translation of the setup data is then complete.

Starting a Manual Excel Translation Export

This guidance covers how to generate a Manual Excel Translation Export, which is the translation export method
best used when users need to send a very limited amount of content to a vendor for translation, or when exporting
Setup Obijects into an Excel file when XML is not a suitable option.

In most cases, creating an Excel translation file through the structured translation process (File > Translate > Data
Objects) is the correct method when an Excel translation export file is required. The Manual Excel Translation
Export method is best used in a limited number of use cases.

Manual Excel Translation Export is a translation method best suited for instances when:

« thereis an extremely limited amount of content to translate

« the translator does not have access to either STEP or a third-party translation tool

« the objects to be translated are setup objects (attribute names, LOVs, and units)

Note: Forindex words, attribute groups, LOV groups, and unit groups, users creating Excel files using the
Manual Excel Translation Export will need to select, one-by-one, all objects to be included in the export file
because selecting the Recursive option will not bring in all child objects for these objects.

Often, the Manual Excel Translation Export process is used in coordination with the translation vendor to correct
an error or process a late addition. Because this translation method represents the most straightforward way to
export a limited number of objects into a single target language, it is considered a good route to efficiently handle
small issues that arise following shipment of a larger translation file.

To Export an Excel File Manually for Translation

To create a Manual Excel Translation Export, open the File menu, point to Translate, and then click Manual
Excel Translation Export.

4 (£~ dev - USERB@http://doc-dev:8D - STEPworkbench
Edit Vi avigate Format Maintain Window Help

Translate A Data Objects...

Import ! Setup Objects...

Export ! q Manual Excel Translation Export
# Reports b Import Translation...

Bulk Update ! Change Translation

Schedule Category Profiling || s ID

The Excel Translation Export wizard displays.
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Step 1 - Select Objects

E] Excel Translation Export @
Steps Select Objects
1. Select Objects i) » [Name » [ObjectType »
2, Select Language > | Add Dt:-jéct(sj- ;
3. Select Format
[] Recursive
Back lex Finish Cancel

In the Select Objects step, the user may select which objects should be included in the Excel translation file being
generated.

If an object has already been selected when initiating the Excel Translation Export, that object will appear pre-
populated as one of the objects in this list. If the object is included in error, be sure to remove it by right-clicking the
object and then selecting Remove Object from the list of options that appear.

1. Click the blue-shaded Add Object(s) text and then, in the Select Additional Nodes for Excel Translation
window that displays, use either the Browse or Search functions to locate and select the objects you want to

translate.

P

E Select Additional Modes for Excel Translation @

Browse m

& Advanced lg_a

Mame

2. Additionally, be sure to add a check to the checkbox beside Recursive if all objects that are 'children’ to the
selected 'parent’ object should also be included in the Excel translation export.
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E! Excel Translation Export @
Steps Select Objects

1. Select Objects D » |Name » |ObjectType »

2, Select Language > | Add Object(s)

3. Select Format

[] Recursive

1}
]

| Cancel

Step 2 - Select Language

The Manual Excel Translation Export allows for one language to be targeted for each export file produced. The
Select Language step allows the user to choose either a source language or a target language as the language
they export the Excel to translate into.

E] Excel Translation Export @
Steps Select Language
1. Select Objects The language for the selected object(s) is English
2. Select Language Select 3 Source or a Target Language for translation.
3. Select Format Source Language  |Endlish
French -
| Back | | Next | | Finish | | Cancel

The first line of text in this window ("The language for the...") informs the user what the source language for the
selected object is. This is determined entirely by what context STEP is set to at that moment. In most cases, the
source language will be correctly set based on the context, and only the target language will need to be chosen.

However, if the user decides to select Source Language and then select a language different from the context
language, the language appearing in the Target Language field will revert from whatever it's set on to the
context-driven source language. As an example, if the context is set to English, but a user changes the source via
the Source Language field to French, the Target Language value will automatically change to English. In effect,
it is not possible to set both the source and target to a language that is not set by the context.
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Step 3 - Select Format

In the final step in the Manual Excel Translation Export, the user selects which kind of Excel document the data
should be exported into.

E] Excel Translation Export @
Steps Select Format
1, Select Objects
2. Select Language
3. Select Format
Expart Format Excel a7/2003 -
Back Mext | [ Finish § [ Cancel

Click the Export Format dropdown list and select the relevant Excel format. The choice is between Excel
documents from the Microsoft Office 97, XP, 2003 versions, or Excel 97 and beyond.

Then click Finish.

A Save window will appear prompting the user to select the location where the Excel document should be saved.
When you have selected the destination location and clicked Save, the export completes, and the exported Excel
document will be available.

The Excel file you exported will look something like this:
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1 |[This sheet is a Stibo Systems translation excel sheet. Please do not change the structure of the sheet. |
2
3 Product: Cotton T-Shirts
4 Source: English Target: French
5 1D "18209 18209
6 Name Cotton T-Shirts Cotton T-Shirts
[ value a value a
& Attribute A, Country Root [text] value b value b
9 value c value c
10 |Brand Owner [text(100)] HanesBrands HanesBrands
11 | Secondary Color [text{100}] Red Rouge
12 Country of Origin [text{100])] CHINA CHINA
The Hanes Beefy-T T-Shirt For over 35 years, it has set
. . the standard for T-shirt comfort and quality. Today it's
Family Description [text{2000] better than ever, offering greater durability and less
13 shrinkage than you'll get with ordinary tees.
14 150Date [isodate] 2014-05-04 2014-05-04
15 Lead Time [integer] 2dy 2 {unece_unit. DAY)
16 Manufacturer Name [text{100})] HanesBrands HanesBrands
17 |Manufacturer Warranty [text(200)] 6 months on workmanship and materials
18 |Brand Name [text{100}] Hanes Hanes
19 |Material [text{100]] Yahoo
20 Product Name [text{10000})] abc Mame 1
21 Selling Unit of Measure [text(100)] EA EA
22 Selling Unit of Measure Qty [integer] M i
23 |Provider GLN [text(100)] 1234567891234 1234567891234

The translation work can be done directly in the Excel file and then imported back into STEP.

Important: Special characters like the greater-than and less-than symbols (> and <, respectively), double and
single quotes, or the double prime (to denote lengths measured in inches), must be mapped in STEP prior to
exporting an Excel file using this method. If this is not done, the file will error on import.

For more information on manually translating content in an Excel file, see the Manually Translating XML and Excel
Files documentation. For information related to importing translation Excel files, see the Importing Translation
Excel Files documentation.

This topic covers the third method of translation content in STEP, manual translation. This topic will cover, in
detail, how a user can translate content in the workbench by adding content directly into the attribute for the target
language.

Manual translation is only appropriate when two criteria have been met:

« translators are given direct access to STEP

« the amount of content to be translated is not substantial

If either of these criteria are not met, the structured translation process is likely to be a better option.
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As an example of an instance where manual translation might be a good option, we'll say that Company Z sells t-
shirts. All of their product information is translated and up to date. Marketing sends a directive that a word used in
the product description for one t-shirt brand needs to be changed for the US and all other global markets. As this
work is very limited in scope, manual translation can be a good (and potentially fast) method to approach this
challenge. In this example, the user would access the product in question, visit each language for that product, and
update the relevant description for each.

Executing a Manual Translation

1. Find the objectin the Tree. In this example, the product to have attribute values translated is 18210 M B.

p#4 Context |Engish US

Ej ETIM Artide Groups

[0 GPC_Root
--@ Index Wards
=-£T] Primary Product Higrarchy

L—‘_}Fj Products

Elr_=| Apparel

E}|__=| Upper Body Wear

(=)-{i5) T-shirts

=il T-shirts Items

- 135442 . 12-GGK79

..... ‘ BR723-12

l STEP Worlflow " Bookmarlks | Tree I

----- E Any Mew Product

=i Cotton T-Shirts

----- E Mew Product 1234

----- | 1s213M0
----- 8 821510

™ Mens T PBO

2. Select the target language you would like to view from the Context dropdown. If, for instance, the user wants
to make a change to the French translation of an attribute, they would select the French FR language from this
dropdown.

File Edit View Mawvigate Format Maintain '

:z Context [Fren::h FR.
: French FR.
English LS
-5 {dqIsrael Hebrew
-5 (HDanish DK

-5 (HEnglish UK

r_=| adFrench Belgium

BT3¢ French Canada
.5 edGErmany German -

m
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3. Clickon Translation Mode. Translation mode displays an object as it exists in two languages, typically the
source and the target. Clicking on Translation Mode will display the target language you chose via the Context,
and the source language will display, by default, as English.

File Edit View Mavigate Format Maintain Window Help

E! Context |English US v | (¥ URL Peditor="1009148workspaceid=Main dﬁtﬂ [E3] (@l 6oto [1DMame »

4. When you switch to Translation Mode, you may receive an instruction dialog that reads like this:

Q Flease select source language

If you see this, follow step four (below), and select the desired source language. Your STEP system will
remember this selection and display it as the source language in Translation Mode until it is changed or the
STEP cache is cleared.

5. To select or change the source language, click View in the File menu, and then Source. In the dropdown that
displays, all available languages that have been designated on your STEP system as either a source or a
target will be listed. Select the relevant source language from these.

File EditN avigate Format

Mode 3 ,E 6
o
hy Workspace k m Refer
E Y UKEnglish
'% ...[ Filter German
Gl B Prirary Hierarchy French
—_ "'[ Select version Danish
ol ot Heb
ﬁ -l Pleae Wieaae oW

6. Inthis example, we have French displaying as the target language on the Product Translation tab (notice the
French FR displaying in the Context field), and Approved UK English as the source language. (The
'Approved' in 'Approved UK English' references the fact that content to be translated, whether manually or
through a structured export, comes from the approved workspace.) Attributes that require translation are
shaded green. In this screenshot, the Long Description attribute is shaded green and has a value in the
Approved UK English column but none in the French column. The green shading is the user's promptto add a
translated value for that attribute. In this example, the attribute needs a French language value.
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B3] context [Frenchrr |G € > ' URL [+Englshaeditor=Transiations| =] [[] (22 [ [ Goto [1oiNane o P
L 4 18210 M B rev.0.25 - Product Translation a
= B Primary Product Hierarchy ~ References || Referenced By || Tables
% [E 0 products
.?Drl ? |_——_|r_=| Apparel
B = EHIT Upper Body Wear > > |approved UK English » [French
| G =0 T-shirts > | |attributey ~
—] I Prud.uct Linking Test > | |Attribute Z
o = T-shirts Items > | IAttwithLangDepLOV
8 8872312 > | |Availabilty End 2015-10-01 11:41:37 2015-10-01 11:41:37
§ = Etton T-Shirts > Backplate Diameter (Cm)
gl ﬁ ﬁﬂg 'L'El.! > Backplate Diameter (In)
It > Brand Qwner HanesBrands HanesBrands
i E 18213 M0 N . e . [T-shirt, short sleeve,
N -{®18216L 0 Bréve Description Article Beefy-T, Mens M, Royal Blue
% a Mens T PBO >" Capacy
@ - Mens T PBG > | lcost 6.35 § 6.35 5
5 -\ Mens T PGS > | |Cost Effective Date 2014-12-16 00:00:01 2014-12-16 00:00:01
:3‘4 ™ Mens T PGW > | |cost Expiration Date  |2016-12-16 13:41:02 2016-12-16 13:41:02
bl - Mens T POY » | |Couleur Primaire Gray Moir
= -\ Mens T PBO > | |Couleur Secondaire Red Rouge
E' -\ Mens T PBG > | Icountry of Origin CHINA CHINA
= ™ Mens T PGS vl Description, Web “
2 M M- T oA
[« > £ >

7. Toadd a value, the user must click into the value cell for the appropriate attribute under the green-shaded
target language column, and then type or paste in the translated value.

< 18210 M B rev.0.25 - Product Translation s

E4 Primary Product Hierarchy G TR EGEEIGON | References || Referenced By || Tables

=l 7 Products

— ’-:-|r_=| Apparel View: Show all =

S E d

= T Ij Upper E’.':' Y Wear > > |Approved UK English * [French »
ol =HER T-shirts > | |Attribute N ~
= o[l Product Linking Test . Attrbute Y

) =il T-shirts Items > |Attribute Z

8 8872312 > | |AttWithLangDepLOV

i =il Cotton T-Shirts > | |avaitabiity End 2015-10-01 11:41:37 20151001 11:41:37
§| - 1s210MB > Backplate Diameter (Cm)

w0 @@ 1821218 > Backplate Diameter (In)
ﬂ E 18213 M O > Orard Narmar HanacRrande HanacRrandg
: E 1821610 T-shirt, short sleeve, T-shirt, manches

2 {8 Mens T PBO » [] Bréve Description Article Beefy-T, Mens M, Roval  |courtes, Beefy-T,

& ™ Mens T PBG Blue Hommes M, bleu royal
E ™ Mens T PGS Y

o, |8 Mens T PGW > | lcost 6.35 § 6.35
il - |f™ Mens T POY » | |Cost Effective Date 2014-12-16 00:00:01 2014-12-16 00:00:01
® {8 Mens T PBO »| |Cost Expiration Date  [2016-12-16 13:41:02 2016-12-16 13:41:02
5 -\ Mens T PBG > | |Couleur Primaire Gray Moir

% P Mens T PGS »|  |Couleur Secondaire Red Rouge

2 ™ Mens T PGW > | |country of Origin CHINA CHINA
== |8 Mens T POY > | |pescription, web
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In this way, most translatable data can be added for all language dependent attributes in all languages. However,
because each language dependent attribute must be amended for each language manually, manual translation is
not recommended for any translation except those with a very limited amount of content to translate.

Note: When using manual translation to translate attributes on the System Setup tab, manual translation using
the Translation mode view only allows you to translate the attribute names, not any of an attribute's description
attributes. However, using Context view, users may manually translate an attribute's description attributes.

Manually Translating XML and Excel Files

This topic provides a detailed description of how to go into a STEP-exported Excel or XML translation file and add
the translated values directly to the file. The files referenced in this documentation are generated through the
structured translation process (Excel or XML), or the Manual Excel Translation Export (Excel). This process is
different from manual translation in that the work is being done to an exported file rather than directly in STEP. To
review the steps required to generate a translation export file through the structured translation process, please
see the Starting a Structured Translation documentation.

When the translation export has been generated (through either the structured translations process or the Manual
Excel Translation Export), the background process will stop at 50% complete.

© Stibo Systems - Confidential - STEP Trailblazer 8.1 41



BG Processes

StiboSystems

181951, en-US > Danish - Background Process

3 /e

--Iﬂ@_‘l MountDocForPlan

--% MultipleRevive

--% ModelistToCollection

--%é_‘l PDF of planned page

--% PageDone

--% Pre-generate thumbnail cache

--%?_‘I Publication Duplication

[ &&= Publish to Website

--% Purge Dimension Point

--%_‘I Purge Matching Data

i % Purge Revisions
@ RuleSetExparter
:é_nl Smartsheet Import

- % StateflowDeadline

--% SuspendBGPs

--%_‘I TDTAFConwvert

EI % Translation (2)

| BG Processes (2)

2 Properties

Property > |Value »
Started by LISERB

Id BGP_132235

Description 181951, en-US = Danish

Execution Server doc-dev

= [ &

ETatls SUspenaea

Created Mon Aug 08 15:58:21 EDT 2016

@ EEmhmREpu’t

OO e

Leaving query senice

MNode selection list was specified. Will automatically accept analysis result

Parsed translation configuration
Logged an

m

..... :& Queued Processes Updating translation status
%MMPM (1) 1 nodes will be exported for translation
i %} 18202, en-J5 = Hebrew Merging table data
-4 157617, enUS > fr Exported nodes
-4t [181951, en-US > Danish| Translation Export Completed
éj',{% 135833, en-USs = fr Delivery started (Mon Aug 08 15:58:23 EDT 2016)
-k 110611, enUS > fr Delivery completed (Mon Aug 08 15:58:23 EDT 2016)
£~ Ended Processes (1)
e o o W[ eman [ [ W
- & Unlink Object Type
EEI--% Update actual page from plan P Result
EEI--% UploadDTPDocument Step Wait for Translation
EI"':%—;‘ Weh LI Asset Fipeline Dowrdoad B Review outcome of the translation analysis: statusfile_BGP_182235.csv =] L2
EEI--% Web UI Download - =
4 m | " Exported translation files: wmitranslation_BGP_182235.zip Eﬂﬂ i
1
Ready __...I

The Progress bar showing at 50% means the export portion of the translation task is complete, but the translation
task itself is paused until the updated file, with all of the translated values added, is imported. The export generates
a zip file that contains the data, in either an Excel or XML format, to be translated. Typically, this file is sentonto a
translation vendor that does the translation work. In some instances, particularly when there are very few objects
that require translation, it may make sense to translate directly within the exported file rather than sending it to a
third party.

At the bottom of the background process is a row called Exported translation files. To the right of that is a disk
icon (&l ). Clicking the icon will allow the user to access the export file.

Translating in an Excel File

The Excel file features a color-coded cell format that quickly alerts the user to each element's status. Below is a
sample of what a user might find in an exported Excel file:
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E:I Battery 3638-Battery 4242.xls [Read-Only] & |I:I|5|
| C =
5 Product: Battery 3638
4 Source: English Target: German
5 (1D Battery 3533 Battery 36533
E [Name Battery 3635 Battery 3635
7 |Text attribute Jtext{ This battery can last forever
2 |Attribute 1 [text{110
9 |Key words [text{500
10
11 Product: Battery 4242
12 Source: English Target: German
13 1D Battery 4242 Battery 4242
14 |[Name Battery 4242 Battery 4242
15 |Text attribute [text{’ This battery cannot last for ever and ever
16 |Attribute 1 [text{110i e
17 |Key worids [text{500
18 .
10
M 4 » H[\Translatiun sheet / | 1 | | LI 4

There are only four cell-shading colors a user may encounter in an Excel export file:

Background color Description

Blue The product name

Green Product information to be translated

Yellow Product information that does not need translation

White Product information that has already been translated and approved

The only cells where the user should take action are those that are color-coded green.

To translate directly in the Excel export file, simply click into the green-colored cell in the target language column,
and insert the translated value of the corresponding value appearing in the source language column. Below is an
example of how this will look when completed for one product and one target language:

© Stibo Systems - Confidential - STEP Trailblazer 8.1 43



StiboSystems

14 Product: Battery Backup

15 Source: English Target: German

16 ID 157617 157617

17 Name Battery Backup Battery Backup

18 |Manufacturer Name Rise-N-5hine Rise-M-Shine

19 |New Product [text(1Yes Yes

20 |Sales ltem Short De: Never miss a wake-up call | verpassen Sie nie einen Weckruf |

When translated values have been added for all of the blank green-colored cells in the target language columns,
the user should save the file, remembering to retain the Excel file extension. The file name can be whatever the
user prefers; STEP keys on the ID information inside the Excel, so the file name has no impact on the translation
process. The file is now ready to be imported.

For more information on importing Excel translation files, consult the Importing Translation Excel Files
documentation.

Translating in an XML File

If the user has elected to export an XML file through the structured translation process, the zip file is accessible via
the disk icon ([Z]) at the bottom of the background process.

The zipped XML translation export file contains these files:

File Description

preview.css Contains style preview information.

preview.xsl Contains style sheet information for displaying translatable content.

preview.tags Contains tag information.

translation.xml | Contains data to be translated. You can translate directly in the XML file. All fields that can be
translated are tagged
<TranslatableText>.

The file where the manual translation work will be done is in the translation.xml file.

To translate directly in the XML export file, the user replaces the source language content that appears between
the <TranslatableText> tags in the XML file. In the screenshot below, you will find yellow-highlighted text
appearing between two red-boxed <TranslatableText> tags. The text highlighted in yellow is what the user
would replace with the translated value.
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Do oo M ionnnnn Bonninnn Shononnne 80 onnninn B0 B0 iinnn B0 nnno i 800 oinonn 3o 0000000000 00280, 0y
&4 </Qualifiers>
&5 <Products>
(13 <Product ID="181%51" UserTypell="Iten" ParentID="13209">
&7 <Name QualifierID="std.lang.all">

68 | <TranslatableText>18216 L C</TranslatableText></Name>
83 «Value AttributeIlD="URL" QualifierID="en-U5">

a4 <TranslatableText>http://www.google.com</TranslatableText>

B85 </Valuer</MultivValue><Value AttributeIl="CostEffectiveDate™ AttributeName=" (CostEffectiveDat:0l</Value><Value Attcior
=13 <TranslatableText>T-shirt, short sleeve, Beefy-T, Mens L, Orange</TranslatableText>

87 <iValue><Value ArctributeIl="AvailabilityEnd" AttributeName=" (AvailabilityEnd)">2015-10-01 1l:4ttributell="LongltemlrID=
1] <TranslatableText>danes Beefy-T short sleeve T-shirt in 100% cotton that resists shrinkage.

L] </Value><Value AttributeIl="IsInvoiceUnit" IL="Y">¥</Value><Value AttkibuteIE="ListPrice" Tnit"™ AttributeName= 152>
30 </Product>

91 </Products>

92 </STEP-ProductInformationTranslation>

When translated values have replaced all relevant content tagged with <TranslatableText>, the user should save
the file, remembering to retain the XML file extension. As with the Excel file, the file name can be whatever the
user prefers; STEP keys on the ID information inside the XML, so the file name has no impact on the translation
process. The file is now ready to be imported.

For more information on importing XML translation files, consult the Importing Translation XML Files
documentation.

Importing Translation XML Files

This topic will cover the process of importing a translation XML file into STEP.

Once the translation vendor has completed translation of the submitted objects in an XML file, the XML file can be
imported into STEP. Importing a translation XML file into STEP will bring all of the new translated values into the
appropriate language contexts.

After the user has initiated an import, but before the import is executed by the system, STEP takes a series of
automated steps to ensure the translated content is handled correctly. Prior to executing an import STEP will:
o Check that the XML is valid (not malformed)

« Checkthat no values in either the source or target language have been modified in STEP since the XML file
was exported

« Check that the imported values match the attribute validation base types in STEP (for instance, if an attribute
restricted to accept only number values is given a free text value, an error is raised)

To start the translation Import Wizard, click File > Translate > Import Translation...

E] | [y-dev - USERE@http://doc-dev:B0 - 5STEPworkbench

Edit Viewlavigate Format Maintain Window Help

Translate

A Data Objects...

Import ! Setup Objects...

Export ! Manual Excel Transla Export
# Reports b ImpurtTransIatinn...P

Bulk Update ! Change Translation

Schedule Category Profiling H « D
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Step 1 - Select file

E] Translation Import @
Steps Select File
1. Select File C:Wsers\brer STIBO\DesktopTranslation Files for Importiwmitranslation_BGP_181287.zip

2. Impaort Options 1
sl Look in: Translation Files for Import - ¥ e

_-jL_ xmltranslation_BGP_181287 zip

File name: xmitranslation_BGP_181287.zip

Files of type: \Zip Files (*.zip), ¥ML Files (*.xml) and Excel Files (*.xds and *.xslx) -

In the Select File step of the Translation Import Wizard, the user must select the XML file they wish to import. To

select the relevant file, navigate in Windows Explorer to the location of your file and select it. Then click Next.

Note: Users may name the import file according to whatever naming convention is most useful to them. The
import process keys entirely off the contents of the file, not the file name, so users have complete freedom in
naming import files. The file must either be an .xmil file or a .zip file with an .xml contained inside.

Step 2 - Import Options

-

E]Translatiu:nn Import =]
Steps Import Options

L. Select File i@ Deliver File to Badkground Process

2. Import Options

7 Import Manually

Details
" The file was exported from process 21929, en-US = i (3:1)

Back Mext I Finish H Cancel

The first option available on this screen, Deliver File to Background Process, is pre-selected because you
have elected to import an XML file. Deliver File to Background Process is the best option.

If the user selects the Import Manually option, a message in red text will appear in the Details section:
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E] Translation Import @
Steps Import Options

1. Select File “1 Deliver File to Background Process

2. Import Options =~

@ Import Manually

Details

The file was exported from workflow 21929, endJs = fr (361).
Importing this file manually may mean that the process will not
terminate since it has not received this file,

Back I Finish H Cancel

m

The last sentence states that, "Importing this file manually may mean that the process will not terminate since it has
not received this file." What this means is that because the user intends to import the file manually, the file will not
be delivered to the background process created to export the XML. The background process is paused at 50
percent post-export, and will not advance to completion (100 percent) unless the file is delivered back to the
background process. This means that if the user selected Import Manually, the translated data may be correctly
updated, but the background process will never advance. If the manual import completes with no errors, users
may update the values in the XML file and import it using the structured import. The background process will
complete.

The primary advantage of Import Manually as it relates to XML files is that it allows a user to import verified data
directly into STEP without the added steps of addressing a background process or forcing the data through
STEP's validation process. In practical terms, if a third-party translator has multiple changes to the same
translation, manually importing each updated XML file can be the most efficient way to update the translation
quickly.

With Deliver File to Background Process selected, click Finish. A File Uploaded to Process window
displays with a message like the one below:

<

E! File Uploaded to Process @

The file xmltranslation_BGP_181287.zip has been
delivered to process 21929, en-US = fr (%3)

Goto Process ]| Close I

To check the progress of the import, click Goto Process. This will take the user to the background process
executing the import.

Once the user has accessed the background process, they should see that:
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« the Progress bar, which was halfway across and paused at 50 percent, is complete and shows a Done

status.
Description 21929, en-US = fr
Execution Server doc-dev
otatus succeeded
Created .'l."'.l'Ed Jul 20 16:02:09 EOT 2016
Started Wed Jul 20 16:02:29 EDT 2016
a2 e

« the final steps listed in the Execution Report section of the background report show that STEP has marked
the "translation of file" complete, and further states that "all pending files have been translated".

@ Execution Report

Import translation process started: BGP 181286 (Wed Jul 20 16:59:36 EDT 2016)

Splitting table data

Marking translation of file ‘translation-BGP_181287-frxml" as completed

Translation of iworkarea/background-processareaTranslation/BGP 181287 /converted. xml finished: 0 Errors, 0 Warnings, 0 Infos
All pending files have been franslated.

L, | 4l | 1-250f25 | [k 3 [ Save... l Truncate

To ensure the translated values were updated as planned, the user may select one of the translated objects,
switch the Context to the target language's context, and find one of the values that was set to translate. The
translated value should display.

For information on how to import Excel files, see the Importing Translation Excel Files documentation.

For more information on how to handle errors that may arise during import of a translation file, see the Handling
Translation Errors documentation.

Importing Translation Excel Files

This topic will cover the process of importing translation Excel files, both via the structured translation process and
through the Manual Excel Translation Export, back into STEP. A successful import will complete a translation task.

When the translation vendor has completed translation of the submitted objects in an Excel document, the Excel
file can be imported into STEP. Importing an Excel file will bring all of the new translated values into STEP in the
appropriate language contexts.

After the user has initiated an import, but before the import is executed by the system, STEP takes a series of
automated steps to ensure the translated content is handled correctly. Prior to executing an import STEP will:

« Check that the Excelfile is intact, meaning no sections have been deleted or amended

« Check that no values in either the source or target language have been modified in STEP since the file was
exported
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« Check that the imported values match the attribute validation base types in STEP (for instance, if an attribute
restricted to accept only numerical values is given a free text value, an error is raised)

To start the Import Wizard, click File > Translate > Import Translation...

-deur - USERB@http://doc-dev:80 - STEPworkbench

Edit Viewghlavigate Format Maintain Window Help
Translate A Data Objects...

Irnport ! Setup Objects...

Export ! Manual Excel Transla Export

# Reports @] Import Translation...
Bulk Update ! Change Translation
Schedule Category Profiling H s D

Step 1 - Select file
E! Translation Import @
Steps Select File
1. Select File

C:Wsers\bror, STIBO\Desktop
2. Import Options
ey Look in: Translation Excel Files for Import

=] Excel Translation_French .xls|

File name:

Files of type: | Zip Files (*.zip), XML Files {*.xml) and Excel Files (*.xls and *.xslx)

ack Mext Finizh Cancel

In the Select File step of the Translation Import Wizard, the user must select the Excel file they wish to import.
Navigate in Windows Explorer to the location of your file and select it. Then click Next.

Note: Users may name the import file according to whatever naming convention is most useful to them. The
import process keys entirely off the contents of the file, not the file name, so users have complete freedom in
naming import files. The file type must be an .xlIs or .xslx file.
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Step 2 - Import Options

E] Translation Import @

Steps Import Options

1. Select File
2. Import Options

Deliver File to Background Process

@ Import Manually

Details

[ Automatically Approve Imported Translation

| Back

| Finish || Cancel |

m

The Import Options step of the Translation Import process will provide different options depending on whether
the Excel file to be imported was done as part of the structured translation process or as a Manual Excel
Translation Export.

If the import file was initially generated through the structured translation process, both import options, Deliver
File to Background Process and Import Manually, will be available. Make your selection and click Finish.

If you select Deliver File to Background Process, a message screen will display showing the process number
assigned to the import action, as well as an option to go directly to the background process executing the import.

If the user elects to go to the background process, and there are no errors, they will see that:

« the Progress bar, which was halfway across and "stuck" at 50%, will complete and show a Done status.

10 BUuF_ 185 1LLS
Description 179927, en-US = Danish
Execution Server docadant

Status coCeeded

« thefinal steps listed in the Execution Report will show that STEP has marked the "translation of file"
complete, and states that "all pending files have been translated".

 Execution Report

179927-179927 xls successfully imported.
Marking translation of file "179927-179927 x5 as completed
All pending files have been translated.
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The user may also select Import Manually for an Excel file generated through the structured translation. If the
import file was initially generated through the Manual Excel Translation Export process, then Import Manually
will be the only available option. After selecting Import Manually, click Finish and the updated values will be
added to the pertinent language. No background process is generated by this action. Any errors that occur will be
surfaced in a dialog that will enable a user to Save, View, or Discard an error report.

Users importing Excel files will have the option to Automatically Approve Imported Translation.

E] Translation Irmport @
Steps Import Options

1. Select File Deliver File to Backaground Process

2. Import Options

@ Import Manually

Detalls

[ Automatically Approve Imported Translation

I Finish || Cancel |

| Back

m

Checking this box automatically changes the status of the object in the target language to Approved once the
import completes. The benefit to checking this box is that it removes the added step of manually approving the
object in the target language after an import. When multiple translations are executed, removing this step can
represent a significant time savings.

To ensure the translated values were updated as planned, the user may switch the Context to the target
language's context and find the values that were in the green-shaded cells. The translated values should appear in
the object record.

In some instances, these processes may generate errors. For more information on the kinds of errors you may
encounter, see the Handling Translation Errors documentation.

Handling Translation Errors

After a translation vendor has completed translation of content, whether in an XML or an Excel file, the file is then
imported back into STEP to complete the translation process. This topic will cover where these errors are
viewable, what sort of errors a user is most likely to encounter, and how best to address those errors. By the end of
this topic, the user should be able to handle most translation errors that may occur.

Most translation import errors occur right after the user has initiated the import process. For more on importing
translation files, see the Importing Translation Excel documentation, or the Importing Translation XML
documentation, whichever is applicable.
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Import Error Notifications

STEP makes the user aware of translation import errors in a number of ways, depending on the scenario. If, for
instance, the user is attempting to import a translation that has already been imported, STEP will respond by
displaying a message window entitled Error sheet....

E! Error sheet... @

The impart reported errors and an error sheet
has been created.

-

[ Save ]| View H Discard I

This window will also display if the user has imported an Excel file manually and STEP has detected errors.

When this window appears, the user is given three options:

« Save: This is the best option if the user knows they want to save the error report. When a user clicks the
Save button, a Save As... window displays. Navigate to the place on your computer where you want to
store the Excelfile listing the errors. In the File name: field, add an appropriate title. An Excel file is
generated that describes the errors.

« View: This is the best option if the user is not clear whether they need to save the error report. Clicking the
View button brings up the same Excel error report the Save button generates. Once the user has viewed the
file, they may decide whether to save it or not.

« Discard -- Clicking the Discard button generates no report and initiates no action. The import process also
does not proceed.

The other way that STEP notifies the user that an import has generated errors is in the Execution Report section
of the import background process. When a translation import is initiated in STEP, the automated steps appear in a
list. If, during the course of executing those actions STEP detects an error, the error will be listed in the report.

For instance, if the XML being imported is malformed, meaning the structure of the XML is in the wrong format,
missing an end tag, etc., STEP will generate an error. In the below instance, part of the XML was deleted in error,
saved, and then imported.

%' Execution Report
Analyse
Impaort translation process started: BGE 181341 (Thu Jul 21 14:28:47 EDT 2016)
Splitting table data

I File translation-BGF 181340-Hebrew xml could not be parsed : Received unexpected:
class org.xml.sax.SAXParseException: Element fype "ClassificationReference”
must be followed by either attribute specifications, ™=" ar "f=".

| 24 Translation failed with 1 error

Pending files: 1
1files are pending.

by 41 | 1-260f26 | b I m

inl]
B
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Translation imports can import with warnings, where only the values affected by the warnings will not import. All
other values unaffected by warnings willimport with no issues.

Itis also possible to view the Execution Report for in-progress translation imports by finding the relevant Active
Process in the Background Processes tab. To access the background process, click the BG Processes tab,
expand Translation, expand Active Processes, and then select the pertinent process. The Execution Report
generated for that import is viewable.

Excel Error sheet

There are a number of ways to view the Excel file listing the translation import errors:

« Access the background process specific to that import and, if errors are present, click the disk icon ( )
located in the Error file: row in the Result section.

% Result
Translated file: xmltranslation_BGP_151340.zip =l
Error file: report_BGP_181341.err &l

Imparting translated file failed, please correct errors.,

For ¥ML, reimport changed XML file. For Excel reimport updated error sheet,

| Done

« Click View or Save when the Error Sheet... pop-up displays upon import.

Below is an example of how the Excel document will be formatted. Only one error is listed in the Validation error
column, though in some instances an error sheet can display multiple errors.

=10 ]
A B | T 3] |§
1 |This sheet is a Stiho Systems translation excel sheet. Please do not change the structure of the sheet.
i
3 Product: Battery 3638
4 Source: English Target: German Validation error
g |l Battery 3638 Battery 3638
The source value has been changed since
export, was:
Text attribute [text{ This battery cannot last forever Diese Batterie kann nicht immer dauern. "This battery cannotlast forever"
i5 now:
(5] "This battery cannot last forever”
—? -
44 ¥ »i]\Translation sheet |«] | [

In this example, the English value "The battery cannotlast forever" was included in the initial translation export into
German. After the translation export but prior to the import, the value was corrected in the English context to be
"The battery cannot last forever". The error was thrown because the English value the STEP validation was
expecting no longer matched the value in STEP. The status for this translation would flip from In Progress to Re-
Translation Needed. To fix this error, a user might consult directly with the translation vendor to determine what
changes, if any, would be required to make the German value accurate based on the updated English value. Once
the German value is deemed correct, the edit can be made directly in the Excel error sheet and then imported.
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Following that, the translation status can be manually changed from Re-Translation Needed to Up to Date,
completing the translation.

The Validation error column can contain a number of errors. Below are some of the most common error
messages a user may encounter:

o The Product does not exist

« Valueis not a “humber, integer, fraction...”

« Invalid Unit for Attribute

« The source Value has been deleted since export. The Value was “[value]’

« Thetarget Value has been deleted since export. The Value was “[value]’

« A source Value has been added since export

« Atarget Value has been added since export

« The source Value has been changed since export. The Value was “[value]’

« The target Value has been changed since export. The Value was “[value]”

« The Unit of the source Value has been changed since export. The Value was “[value].”
« The Unit of the target Value has been changed since export. The Value was “[value]”

« The order of multi Values has been altered. Correct the order or delete multi Values in file.

In some cases, handling these errors will require the user to manually change the translation status and then re-
export (as described in the example above). In some instances, users may correct the error directly in the error
sheet and then import the updated error sheet. For instance, if the value is free text, but the attribute only accepts
numerical values, then the user can address this error directly in the error sheet by amending the error and
importing.

For more information on changing translation status, see the Changing Translation Status and Setup
documentation.

Changing Translation Status and Setup

This topic covers a series of manual steps users can take to quickly rectify issues that may come up during the
translation process. Whether that means accommodating a late change to a shipped translation, or fixing an
incorrectly set source language, this documentation provides guidance on how to use make these adjustments.
Users who have read and understood the content in this topic will know how best to use the Change Translation
and Change Translation Status features.

Though STEP enables users to automate a number of translation tasks, STEP also provides the user with some
flexibility to manually address errors and late changes. For example, let us say a translation file has come back
from the translation vendor and been imported back into STEP. This automatically puts the object into Up to Date
status. But shortly thereafter, the customer has some late updates. To import these updated values, the object's
status must first be manually changed from Up to Date to In Progress. Once changed, the updated file can be
imported.
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Changing the Translation Status

Translation relations, or the link between a source language and a target language, are established automatically
when translation exports are done. In most cases these relations won't need to change, but on rare occasions the
translation relation must be changed manually. Translation relations need to be changed manually when:

« the shipped translation file is corrupt due to a network or hard disk issue. This necessitates resending the
translation export file, which would require manually changing the status from In Progress to Re-
Translation Needed.

« the shipped translation file is missing some content that should have been included. This necessitates
resending the translation export file, which would require manually changing the status from In Progress to
Re-Translation Needed.

To change the translation status, take the following steps:

« Inthe Tree tab, select the object whose status needs to change. Click the Status tab, and then expand the
Translation section by clicking the flipper. Find the translation relation (source language to target language)
where the status needs to be changed, and then click into the cell in the Status column. A dropdown
displays with the available statuses. Select the appropriate status and the change is complete.

[ Product ” Sub Products H References ” Images & Documents ” Commercial H Packaging Hierarchy @I ftate Log ” Tasks l

- Revisions
|©- Workspaces
2 Translation
Master ¢ | Engligh -
Source » [Target > |Status >
> English French Up to Date -
@ Data Pool Subscriptions Re-Translation Needed
In Progress
& Data Pool Publications =
Up to Date

Or o b o
©= Item Authorization Responses

Changing the Source Language

As with the translation status, the source language is established when a translation export is first created and
rarely needs to be changed. But there are some instances where manually changing the source language is the
correct option. For instance, if the user selected French as the source language instead of US English and
identified their error shortly after exporting the translation file, manually changing the source language is the right
option.

To change the source language, take the following steps:

1. Inthe Tree tab, select the object whose source language needs to change. Click the Status tab, and then
expand the Translation section by clicking the flipper. Find the translation relation (source language to target
language) whose source language needs to be changed, and then click into the cell in the Source column.
Selecting a new language completes the task. If the source language has been incorrectly set for one
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translation, it likely needs to be changed for all. If this is the case, repeat this step for all applicable translation
relations.

nid=108200&contextid=Context18id="|[=] [] B ] [ Goto [10/Name -]

18216 L O rev.0.2 - Status
Commercial || Tables || Category Profile || Proof Wiew F State Log || Tasks
R

| Produck ” Sub Products ” References eferenced By ” Images & Documents ]

= Revisions

T Workspaces
D » |Mame » |Path » »

* Main Main Main 0.2
* Approved Approved Approved 0.2
% Translation

Master : | English -

Source * Target > |Status ¥

In Progress

In Progress

In Progress

In Progress

In Progress

2= Approval status in all contexts
=+ Hidden values

(2= Diagnostics

Important: Changing the source language for an object is not possible if no translations have previously been
done for the new source language. For example, let us say an object has only one translation relation: English
(source) to German (target). You want to change the source language from English to French. If the object
has not previously been translated into French, French cannot be selected as the new source. In this example,
only German could be a selectable source language.

2. Next, change the translation status from In Progress to Re-Translation Needed.

3. Finally, re-export the newly amended translation because any previous export files will be nullified by the
change of source language.

As with any significant error that occurs in the translation process, it is always best practice to communicate with
your translation vendor. Given the specific translation configuration you have established with the vendor, they
may provide useful guidance about how best to rectify the error, including steps they can take on their side.
Changing the Translation Setup

If multiple objects require a change to either their source language or translation relations, the Translation Setup
tool enables you to change translation relations on many objects in a single step.
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Important: Use the Change Translation Setup tool with care. Changes to the master language or translation
relations can have a major impact on the translations in your system. We recommend using this dialog when you
have, for example, a limited set of objects where you need to change the master language or translation relations.

1. Inthe File menu, click Translate, and then choose Change Translation. The Change Translation Setup
dialog appears.

E] Change Translation Setup [&J

Input file: |:|

Header lines toignore |0

IDs in file are for: @) Product Aszet Classification

Clear all translation relations (done before above operations)
Set master to Swedish -

Source » [Target > [status >

* |Create tranzlation relation

| oK || cancel

2. Inthe Input file field, click the ellipsis button ( ™ ), and then select the relevant text file. The text file must
contain the IDs of all objects whose translation relations and status you want to change.

Important: Only .txt files can be used. A common way to create this file is to export the relevant objects from
STEP into an Excel, and then copy and paste the data from that Excel into a .txt file.

3. Ifthere are header lines in the text file that you want the system to ignore, enter the number of header lines in
the Header lines to ignore field. The default setting is 0.

4. Forthe IDs in file are for element, select which of the three listed object types the IDs in the .txt file refer to.
The Change Translation Setup tool can only take action on one of the three listed object types (Product,
Asset, and Classification) at a time.

5. Check Clear all translation relations if you want to remove all existing translation relations on the matched
objects. In practice, this will remove all translations that have been created for a given object.

6. If youwant to change the source language for the same target language across multiple objects (e.g., all
translations into French), check the box for the Set master to field, select the desired target language that,
and when you hit OK, any translation relationships with the selected language as the target language will swap
their current source-target translation relation.

Note: Though STEP allows users to check both the Clear all translation relations and Set master to boxes, if
you do check both, be advised that only the Clear all translation relations command will be executed. Set
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master to is a command to take action on existing translation relations. If you have also directed STEP to clear all
translation relations, Set master to will have no translation relations to take action on. Because of these
restrictions, be sure to only check one or the other.

7. Click the Create translation relation text to specify any new translation relation you want to apply to the
objects listed in the .txt file. However, be aware that:

« IfClear all translation relations is checked, all existing translation relations are removed from the
matched products, and the relations specified in this dialog are applied to the matched products.

« If Clear all translation relations is not checked, the existing translation relations on matched products
remain as they are, and the relations specified in this dialog are added to the matched objects.

Searching for Translation Status

This topic addresses how to search for an object's translation status (Up to date, Re-Translation Needed, etc.)
using the advanced search functionality. By reading through this topic, a user should be able to search for and
locate an object's translation status in the STEP workbench.

STEP enables users to quickly search for the translation status of a given object using the Advanced Search
capabilities located on the Search tab. Using either object type, target language, or the translation status as the
search filter, users can find out not only whether an object's translation into a target language is Up to Date, but,
for example, how many products in the Danish context are in Re-translation Needed status.

This functionality may prove useful in a number of common scenarios. For instance, if you know that some
products were updated after the translation export was sent for French translation, you may want to alert the
translation vendor so they know to expect updates for those products. To do this, you could run a search of all
relevant products translating from English to French, that are in Re-Translation Needed status. This would
provide you with a reliable list of all products to query with your translation vendor.

Below is a step-by-step description of how to initiate an advanced search for objects by their translation status.

Initiating a translation status search

1. Verify the relevant context has been selected.

E’ Context _English us - !

Correct selection of context is important because it restricts which languages can be searched as you continue
to build the search. More on this in the description for step five.

2. Clickthe Search tab. The panel below will display in the left navigation panel.
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b 44 Context Engish US

= 7

| © Advanced
=
m -
2 =] Reset Sear::h.
Show Details

| |Name > |

[ Systermn Setup H BG Processes (3) ]

3. Click the Search Criteria Type Selector ( [5== ) and select Translation Status from the dropdown.

4. Inthe Type dropdown, choose the object type you want to search for. The user may choose between these
object types: Classification, Product, Asset, Attribute, and LOV.

-LangjClassification
| |F'rcu:|uct

) Asset h
. WAtribute
lLov

- Translation Status ‘

[] Re-Translation Needed

5. Inthe Language area, select Source language or Target language, and then choose the relevant
language. You may notice that, as default, the source language is set to your current context and grayed out. It
may be changed, but the moment you select Source Language, the Target Language switches to the language

your context is currently set to.
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Search
~ [ Translation Status | =]
Type: :Classiﬁmtiun s
-rLanguage
(™) Source Language | |Endlish
i@ Target Language |D.iirh =
Danish u
-Translation Status Dutch =
Endglish
[ Re-Translation M g
[] In Progress German
Hebrew
[ Up to Date Languange Root
UK English
[] Mot Translated

6. Inthe Translation Status area, check one or more of the listed status types you would like to include in your
search. For instance, including the statuses Re-translation Needed and In Progress in your search will bring
up all objects of the object type selected in step four that are currently in either Re-translation Needed or In
Progress status. These are the status options available to include in your search:

Status Description

Re-translation Needed

Master language has been changed since last translation.

Up to Date

Master language has not been changed since last translation.

In Progress

Translation has been exported, but not yet imported.

Not Translated

Object has never been translated.

7. Click Search.

[¥] Up to Date

[] Mot Translated

= =

8. Ifthe search has generated results, they will display in the Search Results List, located beneath the Add Criteria
/ Operator button ( ).
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9. Clicking on any of the objects listed in the search results will take the user directly to the object.

For more information on the search functionality, see the Search Overview documentation in the Getting Started

guide.
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